Copyright Notices

© 2012, Wyse Technology Inc. All rights reserved.

This manual and the software and firmware described in it are copyrighted. You may not reproduce, transmit, transcribe, store in a retrieval system, or translate into any language or computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, any part of this publication without express written permission.

End User License Agreement (“License”)

A copy of the Wyse Technology End User License Agreement is included in the software and provided for your reference only. The License at http://www.wyse.com/license as of the purchase date is the controlling licensing agreement. By copying, using, or installing the software or the product, you agree to be bound by those terms.

Trademarks

The Wyse logo and Wyse are trademarks of Wyse Technology Inc. Other product names mentioned herein are for identification purposes only and may be trademarks and/or registered trademarks of their respective companies. Specifications subject to change without notice.

Patents

This product and/or associated software are protected by copyright, international treaties, and various patents, including the following U.S. patents: 6,836,885 and 5,918,039.

Restricted Rights Legend

You acknowledge that the Software is of U.S. origin. You agree to comply with all applicable international and national laws that apply to the Software, including the U.S. Export Administration Regulations, as well as end-user, end-use and country destination restrictions issued by U.S. and other governments. For additional information on exporting the Software, see http://www.microsoft.com/exporting.

Ordering Information

For availability, pricing, and ordering information in the United States and Canada, call 1-800-GET-WYSE (1-800-438-9973) or visit us at http://www.wyse.com. In all other countries, contact your sales representative.

FCC Statement

This equipment has been tested and found to comply with the limits for either Class A or Class B digital devices, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Shielded interconnect cables and shielded AC power cable must be employed with this equipment to insure compliance with the pertinent RF emission limits governing this device. Changes or modifications not expressly approved by the system’s manufacturer could void the user’s authority to operate the equipment.

⚠️ Caution

Modifications made to the product, unless expressly approved by Wyse Technology, could void the user’s authority to operate the equipment.
Regulatory Compliance for Thin Clients

Basic EMC and Safety Requirements
Wyse appliances are compliant with the regulatory requirements in the regions listed below.
U.S.A.—FCC Part 15 (class B), cUL 60950
Canada—IC ICES-003, CAN/CSA-C22 No. 60950
Europe—EN 55022 (class B); EN 55024

Canadian DOC Notices

Class A - This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications.
Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la classe A prescrites dans le Règlement sur le brouillage radioélectrique édicté par le Ministère des Communications du Canada.

Class B - This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus set out in the Radio Interference Regulations of the Canadian Department of Communications.
Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la classe B prescrites dans le Règlement sur le brouillage radioélectrique édicté par le Ministère des Communications du Canada.

Wireless Usage and Requirements
Radio transmitting type devices (RF module) are present in models with the wireless option. These devices operate in the 2.4 GHz band (i.e. 802.11B/G/N LAN & Bluetooth).

As a general guideline, a separation of 20 cm (8 inches) between the wireless device and the body, for use of a wireless device near the body (this does not include extremities) is typical. This device should be used more than 20 cm (8 inches) from the body when wireless devices are on and transmitting.

Some circumstances require restrictions on wireless devices. Examples of common restrictions include:

• When in environments where you are uncertain of the sanction to use wireless devices, ask the applicable authority for authorization prior to use or turning on the wireless device.
• Every country has different restrictions on the use of wireless devices. Since your system is equipped with a wireless device, when traveling between countries with your system, check with the local Radio Approval authorities prior to any move or trip for any restrictions on the use of a wireless device in the destination country.
• Wireless devices are not user-serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to use it. Please contact the manufacturer for service.

Device Power Supply
Use only the external power supply that comes with your thin client. For power and voltage ratings, see the serial number label or regulatory label on your device. For power adapter replacement, contact your Wyse Service Representative. For proper replacement compare the labels on both mobile thin client and power adapter to ensure that their voltages match.

⚠️ Warning
Use of any other power adapter may damage your mobile thin client or the power adapter. The damage caused by an improper power adapter is not covered by warranty.

Battery Information
Model Tx0 contains an internal button cell battery replaceable by Wyse or one of our Authorized Service Centers. For service, visit http://www.wyse.com/serviceandsupport/service/service.asp.

⚠️ Warning
There is a risk of explosion if the battery is replaced by an incorrect type. Always dispose of used batteries according to the instructions accompanying the battery.

Perchlorate Materials - Special Handling May Be Required under California Code of Regulations, title 22. (Only required within the U.S.A.)
This page intentionally blank.
Contents

1 Introduction 1
   About this Guide 1
   Finding the Information You Need in this Guide 1
   Wyse Technical Support 1
   Related Documentation and Services 1
   Wyse Online Community 2

2 Getting Started: Quickly Learning the Basics 3
   Logging In 3
   Using Your Home Screen 4
   Home Screen Keyboard Shortcuts 6
   Configuring Thin Client Settings and Connections 6
   Connecting to Network and Session Services 7
   Connecting to a Printer 7
   Connecting to a Monitor 7
   Locking, Logging Out, Shutting Down, Restarting, and Suspending 8
   Additional Getting Started Details 8
   Viewing System Information 8
   Using Wyse Terminal 9
   Restoring Default Settings with WLoader Setup 9
      Accessing Thin Client Boot Order Settings 9
      Restoring Default User Settings 9
   Enhancing Your Experience with Wyse Software 10
      Wyse Device Manager (WDM) 10
      Wyse TCX Suite 10
      Wyse USB Firmware Tool 10
      Wyse Virtual Desktop Accelerator 10

3 Configuring System Settings 13
   Accessibility 14
   Appearance 14
   Background 15
   Date & Time 16
   Device Settings 17
      Terminal Name 17
      Hosts 17
      Ethernet Speed 18
   Diagnostics 18
   Display 19
   ICA Global Settings 20
   Network 20
   Drive Mapping 21
      Adding Drives 21
      Editing and Deleting Drives 21
   Hotkeys 22
   Display 22
   Firewall 23
   Trusted Server Configuration 23
Contents

Import Certificates 24
  Adding Certificates from a Remote Server 24
  Adding Certificates from a Local Device 25
INI Source Settings 25
Keyboard 27
Language Support 27
Mixer 28
Mouse 29
Network Connections 29
Network Proxy 30
Power Manager 30
Printers 31
  Installing a Network Printer 32
  Installing a Local Printer 33
Screensaver 34
TCX Audio 34
TCX USB Virtualizer 35
User Administration 36
VNC Server 37
WDM 37

4 Configuring Connections 39

Custom 40
  Application 40
  Auto Reconnect 40
ICA 41
  Network 41
  Connection 42
  Window 42
  Application 42
  Login 42
  Auto Reconnect 42
  Firewall 43
RDP 44
  Network 44
  Connection 44
  Experience 45
  Window 45
  Application 45
  Login 45
  Auto Reconnect 46
  Drive Mapping 46
    Adding Share Names 46
    Editing and Deleting Share Names 46
  Device Mapping 47
    Adding Devices 47
    Deleting Devices 47
SSH 48
  Network 48
  Connection 48
VMware View Open Client 49
  Network 49
  Window 49
  Login 49
  Connection 49
  Drive Mapping 50
    Adding Share Names 50
    Editing and Deleting Share Names 50
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNC Viewer</td>
<td>51</td>
</tr>
<tr>
<td>Network</td>
<td>51</td>
</tr>
<tr>
<td>Connection</td>
<td>51</td>
</tr>
<tr>
<td>Window</td>
<td>51</td>
</tr>
<tr>
<td>Login</td>
<td>51</td>
</tr>
<tr>
<td>Web Browser</td>
<td>52</td>
</tr>
<tr>
<td>Network</td>
<td>52</td>
</tr>
<tr>
<td>Window</td>
<td>52</td>
</tr>
<tr>
<td>Auto Reconnect</td>
<td>52</td>
</tr>
</tbody>
</table>

### A Central Configuration: Automating Configurations 53

- How INI Files are Employed 53
- How to Set Up Automatic Configuration 54
  - Step 1: Prepare the Root Directory and Folder Structure on the Server 54
  - Step 2: Direct the Thin Client to the Server 56
    - Using DHCP 56
    - Manually Configuring the Server Location 58
  - Step 3: Reboot the Thin Client 58
This page intentionally blank.
Introduction

Wyse® Enhanced Ubuntu™ Linux combines the security, flexibility, and market-leading usability of Ubuntu™ (trademark of Canonical Group Limited) with Wyse's cloud computing optimizations in management and user experience. It is ideal for organizations that want to run server-based, Web-based, or local applications (including legacy applications) without the deployment and security concerns of a non-standard Linux distribution.

About this Guide

This guide is intended for administrators of Wyse thin clients running Wyse Enhanced Ubuntu Linux. It provides information and detailed system configurations to help you design and manage a Wyse Enhanced Ubuntu Linux environment. Depending on your hardware and software configurations, the figures you see may be different than the example figures shown in this guide.

This guide supplements the standard Ubuntu documentation supplied by Canonical Inc. and explains the differences, enhancements, and additional features provided by Wyse with the thin client. It does not attempt to describe the standard features found in Ubuntu.

Ubuntu help can be accessed from the Ubuntu Support Web site at: http://www.ubuntu.com/support.

Finding the Information You Need in this Guide

You can use either the Search window or Find toolbar to locate a word, series of words, or partial word in an active PDF document. For detailed information on using these features, refer to the Help in your PDF reader.

Wyse Technical Support

To access Wyse technical resources, visit http://www.wyse.com/support. If you still have questions, you can submit your questions using the Wyse Self-Service Center at http://support.wyse.com/selfservice.html or call Customer Support at 1-800-800-WYSE (toll free in U.S. and Canada). Hours of operation are from 6:00 A.M. to 5:00 P.M. Pacific Time, Monday through Friday.

To access international support, visit http://www.wyse.com/global.

Related Documentation and Services

Fact Sheets containing the features of hardware products are available on the Wyse Web site. Go to http://www.wyse.com/products/hardware, click the link for your hardware product, and then click the link for the Fact Sheet.
Reference Guide: Wyse® Enhanced Ubuntu™ Linux INI Files is intended for administrators of Wyse thin clients running Wyse Enhanced Ubuntu Linux. It provides the detailed information you need to help you understand and use the Wyse Enhanced Ubuntu Linux INI files. It contains information on the different INI files you can use and the rules for constructing the files. It also provides the parameter details you need (with working examples) to get the most out of your INI files. It is available at: http://www.wyse.com/manuals.


Wyse Online Community

Wyse maintains an online community where users of our products can seek and exchange information on user forums. Visit the Wyse Online Community forums at: http://community.wyse.com/forum.
Getting Started: Quickly Learning the Basics

Use the following information to quickly learn the basics and get started using your thin client:

- "Logging In"
- "Using Your Home Screen"
- "Configuring Thin Client Settings and Connections"
- "Connecting to Network and Session Services"
- "Connecting to a Printer"
- "Connecting to a Monitor"
- "Locking, Logging Out, Shutting Down, Restarting, and Suspending"
- "Additional Getting Started Details"

Tip
While it can be used in environments without central configuration for basic connectivity needs, Wyse Enhanced Ubuntu Linux is designed to be centrally managed and configured using INI files. In general, it is recommended that you use central configuration to enable you to automatically push any desired default configuration to all supported thin clients in your environment (see "Central Configuration: Automating Configurations").

Logging In

Tip
On your initial connection to central configuration it is recommended that you connect using a “wired connection” (plug in the network-connected ethernet cable to your thin client before starting the thin client) to obtain the configurations desired by the administrator (connections, system settings, required certificates and so on). This “wired connection” will also provide any wireless configurations provided by the administrator through the INI files. If you must initially connect to central configuration through wireless, use the Edit Wireless Connection dialog box (click System Settings > Network Connections > Wireless tab > Add) to create a wireless connection where you can enter the SSID and encryption configurations required/set up by the network administrator (see "Network Connections").

After your thin client starts, Administrators can log in to your Home screen using the default user name admin and the default case-sensitive password admin. It is highly recommended that you change the default password by using the User Administration dialog box in System Settings (see "User Administration"). Note that Thinuser users can use the default user name thinuser and the default case-sensitive password thinuser; Guest users can use default user name guest and do not need a password.
Using Your Home Screen

The Wyse Enhanced Ubuntu Linux Home screen is designed for efficiency and usability.

Use the following guidelines (depending on user privilege, some options may not be available for use):

Tip
Each icon has a pop-up description for easy identification.

Table 1  Menu bar icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Displays your Home screen (useful when many windows are open and you want to quickly access your Home screen).</td>
</tr>
<tr>
<td>Open Applications and Connections</td>
<td>Currently open application and connection icons are displayed in the menu bar for convenient access.</td>
</tr>
<tr>
<td>Network Manager</td>
<td>Manages your wired and wireless network connections (see &quot;Connecting to Network and Session Services&quot;).</td>
</tr>
<tr>
<td>Volume</td>
<td>Controls the audio volume (use the slider, click Mute All or Unmute as needed; Note that for these settings to take effect, sound must be supported and enabled on the server used for ICA or RDP connections).</td>
</tr>
<tr>
<td>Calendar</td>
<td>Lists the time, day of the week, and date. You can click the calendar to display the calendar window.</td>
</tr>
<tr>
<td>System Settings</td>
<td>Sets up your thin client hardware, look and feel, and system settings (see &quot;Configuring System Settings&quot;).</td>
</tr>
</tbody>
</table>
### Table 1  Menu bar icons, Continued

<table>
<thead>
<tr>
<th>Icon</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="System Information icon" /></td>
<td>Opens the <em>System Information</em> dialog box. Use this dialog box to view system information about the thin client (see &quot;Viewing System Information&quot;).</td>
</tr>
<tr>
<td><img src="image" alt="Quit icon" /></td>
<td>Opens the <em>Shutdown</em> dialog box. Use this dialog box to lock, logout, shutdown, restart, or suspend your thin client (see &quot;Locking, Logging Out, Shutting Down, Restarting, and Suspending&quot;).</td>
</tr>
</tbody>
</table>

The *Home* screen also contains:

- **Right-click menu** - Right-clicking the menu bar provides options to customize your menu bar and panel. For example, the *Customize Panel* option allows you to move your menu bar to the top, left, bottom, or right of your *Home* screen.

- **Home Screen Application and Connection icons** - Each application and connection icon opens the connections made available by an administrator. For example, a browser, the terminal emulator window (see "Using Wyse Terminal"), or other available connections (see "Configuring Connections").

- **Enter Edit Mode button** - Enters the *Home* screen edit mode allowing you to (depending on user privilege level, some edit mode features may not be available for use; to exit edit mode, click the *Exit Edit Mode* icon):
  - *Edit connections* - Click an icon and configure (see "Configuring Connections")
  - *Delete connections* - Click the delete button of an icon and confirm.
  - *Add new connections* - Click the *Add Item* icon, click the connection you want to add, and then configure (see "Configuring Connections").
Chapter 2

Home Screen Keyboard Shortcuts

Depending on the type of application window you are using (full screen, standard, or seamless), you can use shortcut keys (see Table 2) to manage windows. Note that you can also define shortcuts for launching applications (see "Keyboard").

Tip

The shortcut keys Alt+DownArrow (allows you to switch windows using a dialog box) and Alt+Ctrl+DownArrow (minimizes or maximizes all windows) are useful for navigating multiple remote sessions without having to log out.

Table 2 Window-related Shortcut Keys

<table>
<thead>
<tr>
<th>Window Action</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize window</td>
<td>Alt+F10</td>
</tr>
<tr>
<td>Switch windows using a dialog box</td>
<td>Alt+DownArrow</td>
</tr>
<tr>
<td>Minimize/maximize all windows</td>
<td>Alt+Ctrl+DownArrow</td>
</tr>
<tr>
<td>Move window with arrow keys</td>
<td>Alt+F7 and press an arrow key</td>
</tr>
<tr>
<td>Resize window</td>
<td>Alt+F8 and press an arrow key</td>
</tr>
<tr>
<td>Close the window</td>
<td>Alt+F4</td>
</tr>
</tbody>
</table>

Configuring Thin Client Settings and Connections

While the use of Wyse INI files is recommended to configure thin client settings and connections available to users (see "Central Configuration: Automating Configurations"), you can use dialog boxes on a thin client to:

- Set up your thin client hardware, look and feel, and system settings (see "Configuring System Settings").
- Configure and add connections to your Home screen for use (see "Configuring Connections").
Connecting to Network and Session Services

Use the Network Manager icon, located on the right side of the Menu bar, to display information about the status of your network connection and to connect or disconnect.

Use the following guidelines:

- Click the Network Manager icon to display the Wired Network and Wireless Network menus. For example, you can click the Network Manager icon, and then select an available wired or wireless network to use.
- Right-click the Network Manager icon to display the Enable Networking, Enable Wireless, Enable Notifications, Connection Information, and About options. For example, you can right-click the Network Manager icon, and then click Enable Wireless to remove the check and disable wireless.
- Hover your mouse pointer over the icon to view a message displaying the status (No Network Connection, Wired Network Connection Active, and Wireless Network Connection Active) and name of the network to which your thin client is connected. For example, connecting your thin client to a wired network (by attaching the network cable to your thin client) displays the Wired Network Connection Active status.

For wireless connections (802.11b/g/n Wireless LAN), you can click the Wireless Network Connection icon (or click the Network Manager icon) in the menu bar to see if a wireless network connection is available. You can click an available wireless network connection to open and use the Wireless Network Authentication dialog box. After authentication, the wireless network is available for use.

Tip
For information on importing certificates that your network may require (according to your administrator), see "Import Certificates."

Connecting to a Printer

To connect a printer to your thin client through a USB port, you will need a USB-to-printer adapter cable (not included). Before use, you may need to install the driver for the printer by following the printer driver installation instructions. For information on connecting to printers, refer to "Printers."

Connecting to a Monitor

Monitor connections can be made using the DVI (digital) monitor port and the proper Wyse monitor cables/splitters. For VGA (analog) monitor connections, you must use the included DVI-to-VGA adapter. For information on configuring display settings, see "Display."

Tip
Dual Monitors - When using a DVI to DVI/VGA splitter with VGA and DVI monitors at the same time, note that the VGA monitor will be the primary monitor.
Locking, Logging Out, Shutting Down, Restarting, and Suspending

After using your thin client, you can click the Quit icon and select one of the following (depending on user privilege, some options may not be available for use):

• **Lock** - Locks your thin client (display is blank after you click the icon). To unlock your thin client, move the mouse, enter your credentials, and then click Unlock.

• **Logout** - Logs you out of your session (however, the thin client continues to run).

• **Shutdown** - Shuts down and turns off your thin client.

• **Restart** - Shuts down and restarts your thin client.

• **Suspend** - Places the thin client in Standby mode to preserve power. To exit Standby mode, click the mouse, or press the space bar on the keyboard, or press the return key on the keyboard.

Additional Getting Started Details

This section includes additional details on the following:

• "Viewing System Information"

• "Using Wyse Terminal"

• "Restoring Default Settings with WLoader Setup"

• "Enhancing Your Experience with Wyse Software"

Viewing System Information

Use the System Information dialog box (click the System Information icon in the Menu Bar) to view Identity, Network, Package, System Log, and Copyright information:

• **Identity tab** - Displays identity information such as Current User, Terminal Name, Product Name, Platform, Build, Ubuntu, OS Version, Uptime, Processor, Processor Speed, Total Memory, Free Memory, Flash Size, Serial Number, and BIOS Version.

• **Network tab** - Displays network information for ethernet (eth0) and wireless LAN (wlan0) such as MAC Address, Network Speed, MTU, IP Address, IPv6 Address, Subnet Mask, Gateway, Domain, Primary DNS, Secondary DNS, DHCP Server, Lease, and Elapsed time.

• **Packages tab** - Displays the Package information, including packages names, versions, and sizes that are installed on the thin client.

• **System Log tab** - Displays the System Log information, including various messages generated during the operation of the thin client.

• **Copyright tab** - Displays the software copyright and patent notices.
Using Wyse Terminal

Clicking the Terminal icon on the Home screen opens the Wyse Terminal emulator window. Wyse Terminal allows you access to a text terminal and all its applications such as command line interfaces (CLI) and text user interface applications. You can click the Window menu (upper left window icon in the terminal window) to open and use available menu options. You can type help and press Enter to display a verbose message describing available options. NOTE: Terminal is for various low level administrative purposes. It is available only to users with high privileges. It is recommended for experienced administrators who have extensive knowledge of the Linux system.

Restoring Default Settings with WLoader Setup

Depending on the default settings you want to restore on the thin client, you can use the:

- WLoader Setup to restore various default values (see "Accessing Thin Client Boot Order Settings")
- Recovery option to restore default users settings - that is, user customizations are deleted, however, add-on applications that you installed are retained, and applications that you removed are not restored (see "Restoring Default User Settings")

Accessing Thin Client Boot Order Settings

1. Power off the device.
2. Press and hold the Delete key while pressing and holding the Power button to power on the device.
3. When the Activity light (next to the Power button) blinks, release the Power button.
4. When the BIOS password prompt is displayed, release the Delete key.
5. Type Fireport as the password to enter and use the WLoader Setup. For example, you can use the Boot Order to select the boot option you want.

Restoring Default User Settings

1. Power off the device.
2. Press and hold the P key while pressing and holding the Power button to power on the device.
3. When the Activity light (next to the Power button) blinks, release the Power button.
4. When the one-time boot menu of options is displayed, select the Recovery option and then press Enter.
Enhancing Your Experience with Wyse Software

Wyse provides several software products that are specifically designed to enhance your thin client experience. Wyse Thin Computing Software is available on the Wyse Web site at: http://www.wyse.com/products/software.

**Wyse Device Manager (WDM)**

Wyse Device Manager™ (WDM) servers provide network management services to the thin client (complete user-desktop control—with features such as remote shadow, reboot, shutdown, boot, rename, automatic device check-in support, Wake-On-LAN, change device properties, and so on). With WDM you can manage all of your network devices from one simple-to-use console.

**Wyse TCX Suite**

Wyse® TCX Software™ provides an enrichment layer above ICA and RDP connections that enable flash acceleration, multiple monitor awareness, rich multimedia playback, high quality bidirectional audio capabilities, and seamless USB device access for Wyse thin clients. Each software component in the suite delivers a specific enhancement designed to work seamlessly within a variety of prevalent backend infrastructure solutions such as Microsoft® Terminal Services, Citrix® XenApp, Citrix® XenDesktop, and VMware® View or Virtual Desktop Infrastructure.

Wyse TCX Suite includes:

- Wyse® TCX Flash Acceleration™
- Wyse® TCX Multi-display™
- Wyse® TCX Multimedia™
- Wyse® TCX Rich Sound™
- Wyse® TCX USB Virtualizer™

**Wyse USB Firmware Tool**

The Wyse® USB Firmware Tool™ provides a simple USB imaging solution to help IT and Customer Service staff quickly and easily image supported devices.

Using the tool’s flexible windows utility, users can easily:

- Configure a USB key to copy/pull firmware from a source device (to later push to other target devices)
- Configure a USB key to update/push firmware (that you include on the USB key) to target devices (to update firmware)
- Create replicate/duplicate USB keys (containing the original contents) for simultaneous usage on target devices (by users in several locations at the same time)

**Wyse Virtual Desktop Accelerator**

Wyse® Virtual Desktop Accelerator (VDA) is a software product that, when used with Wyse thin clients and supported PCs, provides an “accelerated” user experience on remote desktop sessions with high round-trip delay between the server and client. By accelerating the remote desktop protocols by a factor of up to 3 times on certain networks, a Wyse VDA session with a server located thousands of miles from your client “feels” similar to a non-accelerated session with a server located just a few hundred miles from your client.

Built for use on high-bandwidth high-latency networks that are prone to packet loss situations, primary use cases for Wyse VDA include:
• Datacenter Consolidation
• Desktop Cloud Computing
• Remote Off-Shore Desktop Computing
This page intentionally blank.
3

Configuring System Settings

Clicking the System Settings icon in the Menu bar displays the following System Settings options that you can configure locally on a thin client using dialog boxes (depending on user privilege level, some dialog boxes and options may not be available for use):

Tip
While it is not recommended to use dialog boxes for configuring thin client system settings, they are available in case you want to temporarily override central default configurations or you do not have the option to set up central configuration (smaller environments). In general, it is recommended that you use central configuration to enable you to automatically push any desired default configuration to all supported thin clients in your environment (see "Central Configuration: Automating Configurations"). In addition, the Wyse USB Firmware Tool also provides a simple USB imaging solution for supported devices (see "Wyse USB Firmware Tool").

- "Accessibility"
- "Appearance"
- "Background"
- "Date & Time"
- "Device Settings"
- "Diagnostics"
- "Display"
- "ICA Global Settings"
- "Import Certificates"
- "INI Source Settings"
- "Keyboard"
- "Language Support"
- "Mixer"
- "Mouse"
- "Network Connections"
- "Network Proxy"
- "Power Manager"
- "Printers"
- "Screensaver"
- "TCX Audio"
- "TCX USB Virtualizer"
- "User Administration"
- "VNC Server"
- "WDM"
Accessibility

Use the **Accessibility** dialog box (click **Accessibility**) to set **Sticky Keys**, **Slow Keys**, and **Bounce Keys** options.

![Accessibility Dialog Box]

Appearance

Use the **Appearance** dialog box (click **Appearance**) to customize your **Home screen** (**Style**, **Icons**, and **Fonts**).

![Appearance Dialog Box]
Background

Use the **Background** dialog box (click **Background**) to customize your desktop background.

- **Tip**
  PNG files are recommended for most single monitor setups. However, on dual-monitor setups, a JPG file is recommended (as there is some color variance due to Y-Cable or DVI/VGA output when using PNG files).
Date & Time

Use the Date/Time Properties dialog box (click Date & Time) to set Date & Time and Time Zone options. After configuring, be sure to click OK.

Use the Date and Time tab to:

- **Synchronize with a Network Time Protocol (NTP) server** - Enter the IP Address or hostname of the NTP server (the current NTP server is shown) to synchronize the clock time and date of the thin client. You can also use Add, Edit, and Delete to manage your list of NTP servers available.

- **Manually set the date and time** - Clear the Synchronize date and time over the network check box, and then select your date and time settings.

Use the Time Zone tab to select your time zone and whether or not to automatically enable daylight savings time (select or clear the System clock uses UTC check box).
Device Settings

Use the **Device Settings** dialog box (click **Device Settings**) to set the parameters of your device (**Terminal Name**, **Hosts**, and **Ethernet Speed**). After configuring, be sure to click **OK**.

**Terminal Name**

Use the **Terminal Name** tab to obtain the device name:

- **Contact DHCP server** - Obtains the name from the DHCP server.
- **Derive from MAC address** - Generates the name from the device MAC address.
- **Use the following name** - Allows you to manually enter a name.

**Hosts**

Use the **Hosts** tab to add mappings of IP addresses to hostnames that are not available through DNS (the names of mapped addresses appear on the **Hosts** tab):

- **Adding an IP address** - Click **Add** to open the `/etc hosts entry` dialog box, enter an **IP Address**, **Hostname**, **Aliases** (optional), and then click **OK**.
- **Editing a Host** - Select a host from the list, click **Edit**, and configure the host.
- **Deleting a Host** - Select a host from the list, click **Delete**, and confirm.
Ethernet Speed

Use the *Ethernet Speed* tab to select the Ethernet speed.

Tip

It is recommended to use *Auto-Detect* in a 1 GB network.

Diagnostics

Use the *Diagnostics* dialog box (click *Diagnostics*) to select and use a diagnostic tool:

- **Ping** - Enter or select a destination from the *Destination* list and click *Ping*.
- **Trace Route** - Enter or select a destination from the *Destination* list and click *Trace Route* (diagnostic information appears on the *Trace Route* tab).
- **Temporary Settings** - View the temporary settings of the thin client.
- **Permanent Settings** - View the permanent settings of the thin client.
- **wlx.ini/wnos.ini** - View the *wlx.ini* or *wnos.ini* file as copied to the thin client.
- **user.ini** - View the *user.ini* file as copied to the thin client.
Display

Use the **Display Preferences** dialog box (click **Display**) to set the monitor display preferences (**Primary Display Output**, **Resolution**, **Refresh Rate**, and **Rotation**). For most monitors, resolution is obtained automatically from the monitor. After configuring, be sure to click **Apply**.

**Tip**

Dual Monitors - When using a DVI to DVI/VGA splitter with VGA and DVI monitors at the same time, note that the VGA monitor will be the primary monitor.

**Tip**

Single-monitor resolution - Maximum is 1920x1080 (16:9); Minimum is 640x480 (4:3).
Dual-monitor resolution - Maximum is 1280x1024 (5:4); Minimum is 720x400 (9:5).
ICA Global Settings

Use the ICA Settings dialog box (click ICA Settings) to configure the common settings you want for all ICA connections (ICA Global Settings). After configuring, be sure to click OK.

Network

Use the Network tab to configure the servers and reconnection settings.

Use the following guidelines:

- **PN Agent Server** - Enter the PN Agent Server you want to use (this can be a list of servers with each server separated by a semi-colon).
- **Metaframe Server** - Enter the Metaframe Server you want to use (this can be a list of servers with each server separated by a semi-colon).
- **Browsing Protocol** - Select the browsing protocol to use from the list.
- **PN Logon Domains** - Enter the PN Logon Domains, and then select your PN Login Method and PN Desktop Setup settings.
- **Window Style** - Select Seamless to display the connection in a seamless window.
- **Application Reconnection** - Select the Automatic reconnection at logon check box to enable reconnection, and then select the connect option you want.
Drive Mapping

Use the Drive Mapping tab to map drives on the server to devices on the thin client, and to view and manage (add, edit, and delete) the list of current drives (including drive information) mapped on the thin client.

Adding Drives

1. Click Add to open the ICA Drive Map dialog box.
2. Select a drive letter (A to Z) from the Drive Letter list.
3. To enable or disable reading and writing for the drive, select or clear the Enable Read and Enable Write check boxes.
4. Select a drive type (USB Floppy, USB CDROM, USB Disk or Memory Stick, or Local or Mounted Disk) from the Drive Type list.
5. (Optional) Enter the directory on the USB device to access in the Base Directory text box.
6. Click OK to add the drive to the list of available drives.

Editing and Deleting Drives

To edit or delete a drive, select a drive from the list of available drives and do one of the following:
• Edit - Click Edit and configure the drive as described in "Adding Drives."
• Delete - Click Delete to remove the drive.
Chapter 3

Hotkeys

Use the Hotkeys tab to map hotkeys on the thin client (select a Hotkey option using the Hotkey lists for each function you want).

Display

Use the Display tab to set:

- **Scroll Adjustment** - If you encounter over-scrolling when using certain published applications, increase the adjustment by 100 until the display improves (maximum scroll adjustment is 1000).
- **PrintScreen** - Select to use the Print Screen key to capture an image of the screen to the Clipboard (used for ICA XCapture support). If the check box is selected, a message appears warning about the influence of this setting on other applications).
Firewall

Use the *Firewall* tab to set the firewall options on the thin client:

- **Automatically detect proxy** - Detects proxy servers automatically.
- **Use Alternate Address for Firewalls** - Enables connections behind a firewall.
- **Proxy Type** - Select a Proxy Type from the list and if necessary (Secure (HTTPS) or SOCKS, enter the *Proxy Address* and *Port*).

Trusted Server Configuration

Use the *Trusted Server Configuration* tab to set and enforce the trusted server configuration. To enforce a trusted server configuration, select the **Enabled** option, select the **Enforce trusted server configuration** check box, enter the *Address* of the trusted server, and then click **OK** (you can also use the **Enabled** or **Disabled** options to quickly enable or disable the enforcement configuration).
Import Certificates

Use the **Import Certificates** dialog box (click **Import Certificates**) to import and manage (add and delete) ICA Digital Certificates as described in "Adding Certificates from a Remote Server" and "Adding Certificates from a Local Device."

Adding Certificates from a Remote Server

Use the following guidelines (certificate files you add from a remote server must end with the extension .crt, and be DER-encoded or Base64-encoded):

1. In the **Import Certificates** dialog box, click **Add** to open the **Add Certificate** dialog box.

2. Select the **Remote Server** option, and then click **Next** to open the **Certificate Import Server Settings** dialog box.

3. Select the **Remote Certificate Source** server option that contains the certificate you want. If you select the **Use the following Server** option, enter the **Import Server URL** (supported protocols are ftp, http, and https) and the **User name**, and **Password** required for that server.

4. Select the certificate file from the **Certificate file** list (if the **Import Server URL**, **User name**, and **Password** are entered correctly, this list automatically displays the names of available certificates on the server).

5. After the configuring the **Remote Certificate Source** server option you selected, click **Add**.
Adding Certificates from a Local Device

1. In the **Import Certificates** dialog box, click **Add** to open the **Add Certificate** dialog box.

2. Select the **Local Server** option, and then click **Next** to open the **Open File** dialog box.

3. Use the folders and command buttons to find and select the certificate you want to use.

INI Source Settings

Use the **INI Settings** dialog box (click **INI Settings**) to direct the thin client to the source (server location) of INI files.

- **Caution**
  It is recommended to obtain INI files through a DHCP server using DHCP options rather than through a static IP address. For information about how INI files are downloaded from a server, see "How to Set Up Automatic Configuration."

- **Tip**
  Wyse devices also support INI changes through Wyse Device Manager’s DDC (see "Wyse Device Manager (WDM)" and "WDM").
Use the following guidelines:

- **Do not use INI files** - Use this option when you want to use only locally configured settings (using the thin client dialog boxes available) and do not want to use available INI files on the network or local INI files.

- **Use INI files from server only** - Use this option when you want to use INI files from the specified server only (for example, you do not want to use local INI files or do not want to allow INI use when disconnected from the server for security reasons). When using this option you can direct the thin client to the server location through either of the following ways:
  - **DHCP Server** - Select the Get INI and Upgrade server details via DHCP check box. The DHCP server will direct the thin client (using DHCP options) to the server location where the INI files reside.
  - **Manually entered server address** - Clear the Get INI and Upgrade server details via DHCP check box and enter the static INI Settings (INI Server URL, and optionally the Username and Password of the server, if selecting the Server requires authentication check box).

- **If server is available, use INI files from server only; otherwise use local INI files** - Use this option when you want to use INI files from the specified server, however, local INI files can be used if that server is unavailable. When using this option you can direct the thin client to the server location through either of the following ways:
  - **DHCP Server** - Select the Get INI and Upgrade server details via DHCP check box. The DHCP server will direct the thin client (using DHCP options) to the server location where the INI files reside.
  - **Manually entered server address** - Clear the Get INI and Upgrade server details via DHCP check box and enter the INI Settings (INI Server URL, and optionally the Username and Password of the server, if selecting the Server requires authentication check box).

- **Use local INI files only** - Use this option when you want to use only local INI files and do not want to use available INI files on the network.

---

**Tip**

INI files can be cached locally if using the EnableLocal and LocalCopy INI parameters; see Reference Guide: Wyse® Enhanced Ubuntu™ Linux INI Files.
Keyboard

Use the **Keyboard** dialog box (click **Keyboard**) to select **Behavior** (repeat key and cursor blinking options), **Application Shortcuts** (add/remove shortcuts for launching applications and reset to defaults options), and **Layout** (keyboard models and layout options).

**Tip**

For information on available **Home** screen keyboard shortcuts, see "Home Screen Keyboard Shortcuts."

Language Support

Use the **Language & Text** dialog box (click **Language Support**) to select the **Language** and **Text** format options of the User Interface (UI) from the list of supported languages. Note that currently only English is supported.

**Tip**

Additional language packs can be downloaded and installed as they become available from Wyse at: [www.wyse.com/download](http://www.wyse.com/download).
Mixer

Use the Mixer dialog box (click Mixer) to configure Playback (Master system sounds) volume and other available controls.

Select the Sound Card option you want and use the Select Controls dialog box (click Select Controls) to select the check boxes of the audio controls you want visible (tabs) in the Mixer dialog box (available for configuration). For example, you can display a capture sound card option (for recording sounds), output sound card (with playback, capture, and switches preferences), and so on.

Tip

Clicking the volume button toggles the mute on and off.
Clicking the link button toggles the select-all-sliders feature (all sliders move as one) on and off.
Clicking the record button toggles the record sound on and off.

Tip

For these settings to take effect, sound must be supported and enabled on the server used for ICA connections, RDP connections, or MPlayer. Sound requires significant bandwidth that may not be available on some WAN and dial-up connections.
Mouse

Use the **Mouse** dialog box (click **Mouse**) to select **Devices** (button order, feedback, and reset to defaults options) and **Behavior** (drag-and-drop and double-click options) mouse preferences.

![Mouse dialog box]

Network Connections

Use the **Network Connections** dialog box (click **Network Connections**) to configure the settings you want for supported network connections. Use the **Wired**, **Wireless**, **Mobile Broadband**, **VPN**, and **DSL** tabs to view and manage (add, edit, and delete) the list of network connections configured on the thin client. By default, your thin client obtains information from the DHCP server about network connections (highly recommended), but you can manually enter connection information (provided by your network administrator) to connect to other networks (experienced users only).

![Network Connections dialog box]
Network Proxy

Use the **Network Proxy Preferences** dialog box (click **Network Proxy**) to configure the **Proxy Configuration** and **Ignored Hosts** options you want for supported network connections. Use the **Proxy Configuration** and **Ignored Hosts** tabs to view and manage proxy settings and list of hosts to ignore (information provided by your network administrator) for the network connections configured on the thin client (experienced users only).

Power Manager

Use the **Xfce Power Manager** dialog box (click **Power Manager**) to select the time of inactivity (using the slider) before placing the thin client into sleep mode. Press the **Power** button to wake the thin client from sleep mode.
Printers

Use the Printers dialog box (click Printers) for printer related tasks.

Tip

While this section provides an overview of printer related guidelines to use, see "Installing a Network Printer" and "Installing a Local Printer" for detailed procedures. For full details on Linux printing, refer to CUPS documentation.

Use the following guidelines:

- **CUPS and Home tabs** - View and access CUPS information (click the CUPS tab or the Home tab) - CUPS is the standard-based, open source printing system developed by Apple Inc. for Mac OS® X and other UNIX® -like operating systems.

- **Administration tab**

  Printers:
  - **Add Printer** - Add and configure a network or local printer (click the Administration tab > Add Printer to open and use the Add Printer wizard). See "Installing a Network Printer" and "Installing a Local Printer" for detailed procedures.
  - **Find New Printers** - Find available printers for use.
  - **Manage Printers** - View the list of currently configured printers (click Administration tab > Manage Printers). In addition, you can:
    - Select the default printer (select a printer in the list and click Printer > Set as Default). Note that administrators can specify system-wide and personal default printers.
    - Change printer settings (right-click a printer in the list, select Properties, and then click Settings).
    - Change printer policies (right-click a printer in the list, select Properties, and then click Policies).
    - Change user access to the printer (right-click a printer in the list, select Properties, and then click Access Control).
    - Change printer job options (right-click a printer in the list, select Properties, and then click Job Options).
    - Delete a printer (right-click a printer in the list, select Delete, and click OK).

  Classes:
  - **Add Class** - Add and configure a Class of printers (click the Administration tab > Add Class to open and use the Add Class wizard).
  - **Manage Classes** - View the list of currently configured Classes of printers (click Administration tab > Manage Classes).
Jobs:
- Manage Jobs - Change printer job options (click Administration tab > Manage Jobs).

Server:
- Edit Configuration File - Change the server configuration file (click Administration tab > Edit Configuration File).
- View Access Log - View the access log to the server (click Administration tab > View Access Log).
- View Error Log - View the error log to the server (click Administration tab > View Error Log).
- Advanced Check Boxes - Select or clear the check boxes you want in the Advanced list; after making your selections, be sure to click Change Settings.

RSS Subscriptions:
- Add Subscription - Add and configure an RSS subscription (click the Administration tab > Add Subscription to open and use the Add RSS Subscription wizard).

Classes tab - Search for printers of a class type.
Online Help tab - Access CUPS online help interface.
Jobs tab - Search and display printing jobs.
Printers tab - Search and display printers (with printer details).

Installing a Network Printer

1. Click Administration tab > Add Printer to open the Add Printer wizard.

2. Select the printer option you want from the Discovered Network Printers or Other Network Printers lists and follow the Add Printer wizard using the following guidelines:
   - AppSocket/HP JetDirect - Use this option for a printer connected directly to the network instead of through a computer.
   - Internet Printing Protocol (IPP) - Use this option for a printer attached to a different Linux system on the same network running CUPS or a printer configured on another operating system to use IPP (http printing).
   - Internet Printing Protocol (HTTP) - Use this option for a printer attached to a different Linux system on the same network running CUPS or a printer configured on another operating system to use HTTP (ipp printing).
   - LPD/LPR Host or Printer - Use this option for a printer attached to a different UNIX system that can be accessed over a TCP/IP network (for example, a printer attached to another UNIX system on your network) or a thin client used as an LPD (Line Printer Daemon) server for LPD printing requests from the network. You can enter the DNS or WINS name of the server for the network printer, or an IP address can also be entered. Note that if the printer is attached to another thin client on your network, the entry in the Host box is the name or address of that thin client.
Installing a Local Printer

Connect the printer cable to your thin client and use the following guidelines:

1. Click **Administration tab > Add Printer** to open the **Add Printer** wizard.

2. Be sure the USB printer you connected to your thin client is selected and click **Continue**.

   **Tip**
   You can use the **Serial Port # 1** and **Serial Port # 2** options as needed for your local serial port printers.

3. Select the option with which you want to obtain your printer driver and click **Continue**.

4. Select the Model and Driver and click **Continue**.

5. Enter the **Printer Name**, **Description**, **Location**, and then click **Apply**. The printer is added to the **Manage Printers** list (click **Administration tab > Manage Printers**) and is ready for use.
Screensaver

Use the Screensaver Preferences dialog box (click Screensaver) to Display Modes (select screen saver theme settings) and Advanced (display power management) settings.

Tip

Press the Power button to wake the computer from standby or sleep mode.

TCX Audio

Use the Audio Devices dialog box (click TCX Audio) to view and change the automatically-detected audio device (for example, a connected audio headset/device will be automatically detected) you want to use for your audio output (select the Audio device you want and click OK).
TCX USB Virtualizer

Use the **TCX USB Virtualizer Configuration Utility** dialog box (click **TCX USB Virtualizer**) to view and manage (add, edit, and delete) the list of current device classes (on the **Configuration** tab) and to view the list USB devices enabled or denied for use on the thin client (on the **USB Devices** tab). You can deny a device class, but still permit a USB device in that class to be used, by adding it to the **Devices** list of the **Configuration** tab.

Use the following guidelines:

- **Enabling USB devices** - Select the **Enabled** check box.

- **Allowing or denying USB device classes** - On the **Configuration** tab, select or clear the check box of a device class in the **Devices** list to allow or deny its use. For example, select **Smart Card Devices** to permit USB smart card devices to be used to log into virtual machines.

- **Adding a USB device** - On the **Configuration** tab, click **Add** to open the **Add** dialog box, enter a **Device Name**, select a class for the device from the **Class** list, enter the **Sub Class**, **Vendor ID**, **Protocol**, and **Product ID**, and then click **Add**. After you reboot your thin client, the name of the new device appears on the **Configuration** tab.

**Tip**

You can obtain device **Class**, **Sub Class**, **Protocol**, **Vendor ID**, and **Product ID** information by plugging the device into the USB port of your thin client and viewing the information displayed in the **USB Devices** tab.

- **Allowing or denying a USB device** - After you add a USB device, its name appears on the **Configuration** tab. Select or clear a USB device check box to allow or deny its use.

**Caution**

Use caution when using TCX USB Virtualizer on a terminal server, as allowing use of a USB device is global and not session restricted.

For information on the TCX USB Virtualizer component of Wyse TCX Suite software, refer to "Wyse TCX Suite."
User Administration

Use the User Administration dialog box (click User Administration) to view and edit passwords for all users (built-in defaults) and to enable automatic login for a user (automatically log in a user at system start up). In addition, you can manage SSH root User password and login (using the SSH root User tab).

⚠️ **Caution**

While this dialog box allows you to edit the passwords and automatic login for users of the thin client, you must use central configuration (INI files) to add or delete users beyond the built-in default users provided. In general, it is recommended that you use user.ini files to manage users for normal use cases. For example, a new user should be created through a user.ini file with the appropriate privilege level defined in the text file.

To edit a user password, select the change password check box you want, and then enter a new password in the New Password and Confirm Password boxes.

팁

The Users tab can be a convenient way to locally change the password and enable automatic login for a specific user.
VNC Server

Use the **VNC Server Settings** dialog box (click **VNC Server**) to enable and disable the VNC server, and to use and change the server password.

**Tip**

The VNC server is enabled by default.

![VNC Server Settings dialog box](image)

WDM

Use the **WDM Agent Configuration** dialog box (click **WDM**) to configure the Wyse Device Manager server location.

**Tip**

It is recommended that after configuring, you reboot the thin client.

![WDM Agent Configuration dialog box](image)

To configure the WDM server location:

1. Enter the **WDM Server** IP address.
2. Enter the **Client to Server Port** (default, is 80).
3. Enter the **Secure Port** (HTTPS port default is 443).
4. Click **OK**.

**Tip**

Note that you can also configure the Wyse Device Manager server location through INI files (wlx.ini) or the DHCP Option tag 186 (see "Central Configuration: Automating Configurations").
This page intentionally blank.
4

Configuring Connections

This chapter provides instructions on configuring and adding connections to your Home screen for use (to access the enterprise server environment available to the thin client).

**Tip**

While it is not recommended to use dialog boxes for configuring connections for thin client use, they are available in case you want to temporarily override central default configurations in some cases or you do not have the option to set up central configuration (smaller environments). In general, it is recommended that you use central configuration to enable you to automatically push any desired default configuration to all supported thin clients in your environment (see "Central Configuration: Automating Configurations").

In addition, the Wyse USB Firmware Tool also provides a simple USB imaging solution for supported devices (see "Wyse USB Firmware Tool").

Clicking **Enter Edit Mode > Add Item** on the Home screen opens the Connection Manager. Use the Connection Manager to add the following items to your Home screen for use (high privilege users only):

- "Custom"
- "ICA"
- "RDP"
- "SSH"
- "VMware View Open Client"
- "VNC Viewer"
- "Web Browser"
Custom

Use the **Custom Connection Configuration** dialog box (click **Custom**) to set custom connection configurations. After configuring, be sure to click **OK**.

![Custom Connection Configuration dialog box](image)

### Application

Use the **Application** tab to configure:

- **Description** - Enter the description.
- **Command Line** - Enter the command line for the program on the server.
- **Run in terminal window** - Runs the application in a terminal window (use with applications that require a terminal window such as a console program).
- **Auto Connect** - Starts the connection automatically after system startup.

### Auto Reconnect

Use the **Auto Reconnect** tab to enable automatic reconnect after a disconnection (select the **Enable Auto Reconnect** check box, and then select the amount of time to delay the reconnection attempt after a disconnection occurs).
ICA

Use the Citrix ICA Client Settings dialog box (click ICA) to set ICA connection configurations. After configuring, be sure to click OK.

Tip

When using multiple ICA connections, you can use the ICA Connection Center to manage open ICA connections. For information on using multiple ICA connections, refer to the Wyse Knowledge Base on the Wyse Web site.

Network

Use the Network tab to configure the network settings:

- **Server or Published Application** - Select an option for making the connection.
- **Description** - Enter a name/label for the connection.
- **Network Protocol** - Select a network protocol.
- **Browser Server** - Enter the Browser Server name (this can be a list of server names with each name separated by a semi-colon).

Tip

You do not need to enter a browser server name if you do not want to connect to either a published application or a server by name. In addition, generating an ICA connection to a server using a server name in the Server text box for the connection does not require a Browser Server address, as long as the DNS information is properly entered.

- **Server or Application Name** - Select a server from the Server list or a published application from the Application Name list. If needed, click Refresh to refresh the list of servers or published applications.

Tip

You can enter only the IP address of the target server as long as there is no need to resolve a name.
Connection

Use the Connection tab to configure the connection settings:

- **Enable compression** - Enables compression.
- **Low bandwidth** - Enables low-bandwidth optimization.
- **Enable sound** - Enables sound.
- **Ping before connect** - Pings the connection to see if it is reachable before the connection is attempted.
- **Enable Middle Button Paste** - Enables middle button paste for the mouse.
- **Encryption** - Select an encryption type (default is Basic).

Window

Use the Window tab to select the Window Colors and the Window Size you want, and to disable the panel (if you want the window to appear without the panel while using the connection).

Application

Use the Application tab to enter the command line and Working Directory of the application (if you selected the Published Application option on the Network tab):

- **Command Line** - Enter the command line for the program on the server.
- **Working Directory** - Enter the working directory for the program.

Login

Use the Login tab to configure credentials used to automatically log in to the server:

- **User Name** - Enter a user name for the connection.
- **Password** - Enter the password.
- **Domain** - Enter the domain name.
- **Serial Number** - Enter the serial number for Metaframe environments that require the thin client license serial number.
- **Connect automatically after login** - Enables an automatic connection after successful login to the thin client.

**Tip**

The User Name, Password, Domain, and Serial Number fields are optional. If the User Name, Password, and Domain fields are blank, interactive login is required (users must enter the information at login time).

Auto Reconnect

Use the Auto Reconnect tab to enable automatic reconnect after a disconnection (select the Enable Auto Reconnect check box, and then select the amount of time to delay the reconnection attempt after a disconnection occurs).
Firewall

Use the Firewall tab to configure an alternate address for firewalls:

- **Automatically detect proxy** - Select to automatically detect the proxy type.
- **Use Alternate Address for Firewalls** - Select Yes to use an alternate address for firewalls.
- **Proxy Type** - Select a proxy type.
- **Proxy Address** and **Port** - If you select Secure (HTTPS) or SOCKS as the Proxy Type, you must enter the Proxy Address and Port.

Tip

Published applications do not support Firewall functions.
Use the **Remote Desktop Protocol (RDP) Configuration** dialog box (click RDP) to set RDP connection configurations. After configuring, be sure to click **OK**.

### Network

Use the **Network** tab to configure the network settings:
- **Description** - Enter a name/label for the connection.
- **Server** - Enter a server name or IP address.
- **Ping Before Connect** - Pings the connection to see if it is reachable before the connection is attempted.
- **Notify When Disconnected** - Notifies you when the connection is broken.

### Connection

Use the **Connection** tab to configure the connection settings:
- **Compression** - Enables compression.
- **NT4 compatible** - Enables RDP protocol version 4.
- **Low bandwidth** - Enables low-bandwidth optimization.
- **Sound** - Select audio source for the connection (**Local** or **Remote**).
- **Encryption Level** - Select an encryption level (**Normal** or **None**).

---

**Tip**

For servers with data encryption settings, you must select **Normal** for the encryption level.
Experience

Use the Experience tab to configure the experience settings for a user desktop:

- **Speed Level** - Select a speed level to describe the network connection.
- **Menu and window animation** - Enables menu and window animation.
- **Show contents of window while dragging** - Shows the window content when the user drags the window on screen.
- **Desktop Background** - Displays the desktop background.

**Tip**

Consider your network restrictions when you select options on the Experience tab. For example, be sure to configure the settings appropriately for your bandwidth level and so on.

Window

Use the Window tab to select the **Window Colors** and the **Window Size** you want, and to disable the panel (if you want the window to appear without the panel while using the connection).

Application

Use the Application tab to enter the command line and Working Directory of the application that will run at the beginning of a session:

- **Command Line** - Enter the command line for the program on the server.
- **Working Directory** - Enter the working directory for the program.

Login

Use the Login tab to configure credentials used to automatically log in to the connection:

- **Use smart card** - Enables the use of a smart card when connecting.
- **Network Level Authentication** - Enables the use of Network Level Authentication (NLA) when connecting. Be sure to enable NLA if NLA is enabled on your remote computer (your remote computer requires NLA user authentication before you establish a full Remote Desktop connection and the logon screen appears).
- **Use RD Gateway settings** - Enables the use of Remote Desktop Gateway (RD Gateway) server when connecting. If required, then enter the IP address or URL of the RD Gateway server. You can also enable **Use Remote Desktop Credentials for RD Gateway** (if the server credentials are the same credentials as your Remote Desktop Credentials (Host remote computer credentials) in the User Name, Password, and Domain fields below) or disable **Use Remote Desktop Credentials for RD Gateway** and enter the RD User Name, RD Password, and RD Domain of the RD Gateway server if required.

**NOTE**: An RD Gateway server is a type of gateway that enables authorized users to connect to remote computers on a corporate network from any computer with an Internet connection. An RD Gateway server enables Remote Desktop connections to a corporate network from the Internet without having to set up virtual private network (VPN) connections. Ask your network administrator whether you need to specify an RD Gateway server.

- **User Name** - Enter a user name for the connection.
- **Password** - Enter the password.
- **Domain** - Enter the domain name.
• **Connect automatically after login** - Enables an automatic connection after successful login to the thin client.

**Tip**
The User Name, Password, and Domain fields are optional. If you leave any of these fields blank, interactive login is required (users must enter the information at login time).

**Auto Reconnect**

Use the *Auto Reconnect* tab to enable automatic reconnect after a disconnection (select the *Enable Auto Reconnect* check box, and then select the amount of time to delay the reconnection attempt after a disconnection occurs).

**Drive Mapping**

Use the *Drive Mapping* tab to map share names on the server to USB mass storage devices attached to the thin client, and to view and manage (add, edit, and delete) the list of current server share names (including drive information) mapped on the thin client.

**Adding Share Names**

1. Click **Add** to open the *RDP Drive Map* dialog box.
2. Enter a **Share Name**.
3. Select a **Drive Type** (*USB Floppy, USB CDROM, USB Disk or Memory Stick*, or *Local or Mounted Disk*).
4. (Optional) Enter the directory on the USB device to access in the **Base Directory** text box.
5. Click **OK** to add the **Share Name** to the list of available **Share Names**.

**Editing and Deleting Share Names**

To edit or delete a **Share Name**, select a **Share Name** from the list of available **Share Names** and do one of the following:

- **Edit** - Click **Edit** and configure the **Share Name** as described in "Adding Share Names."
- **Delete** - Click **Delete** to remove the **Share Name**.
Device Mapping

Use the Device Mapping tab to map devices to ports on the thin client, and to view and manage (add and delete) the list of current devices (including device information) mapped on the thin client.

Adding Devices

1. Click Add to open the Add Port Mapping dialog box.
2. Select a port from the Port list.
3. Select the directory of the device to access from the Device list.
4. Click OK to add the device to the list of available devices.

Deleting Devices

To delete a device, select a device from the list of available devices and click Delete.
**SSH**

Use the **SSH Configuration** dialog box (click **SSH**) to set SSH connection configurations. After configuring, be sure to click **OK**.

![SSH Configuration dialog box](image)

**Tip**

X forwarding/tunneling is automatic and allows you to execute remote X applications.

**Network**

Use the **Network** tab to configure the network settings:

- **Description** - Enter a name/label for the connection.
- **Host** - Enter a host name or IP address.
- **Remote Username** - Enter a username.
- **Remote Command** - Enter the command to execute on the server.

**Connection**

Use the **Connection** tab to configure the connection settings:

- **Auto Connect** - Starts the connection automatically after system startup.
- **Ping Before Connect** - Pings the connection to see if it is reachable before the connection is attempted.
- **Auto Reconnect** - Reconnects automatically after a disconnection occurs.
- **Delay before retrying** - Select the amount of time to delay the reconnection attempt after a disconnection occurs.
VMware View Open Client

Use the VMware View Client Settings dialog box (click VMware View Open Client) to set VMware View Client connection configurations. After configuring, be sure to click OK.

Network

Use the Network tab to configure the network settings:

- **Description** - Enter a name/label for the connection.
- **Host** - Enter the VMware View Server location (either host name, a full URL including the root path, or an IP Address).
- **Port** - Enter the port of the host.
- **Use Secure Connection (SSL)** - Select to use an SSL connection.
- **Enable interactive mode** - Enables interactive mode.

Window

Use the Window tab to select a Display size and whether to use full screen on all monitors, and to disable the panel (if you want the window to appear without the panel while using the connection).

Login

Use the Login tab to configure credentials used to automatically log in to the connection:

- **User Name** - Enter a user name for the connection.
- **Password** - Enter the password.
- **Domain Name** - Enter the domain name.
- **Desktop** - Enter the desktop name.

Connection

Use the Connection tab to configure the connection settings:

- **Ping Before Connect** - Pings the connection to see if it is reachable before the connection is attempted.
- **Connect automatically after login** - Enables an automatic connection after successful login to the thin client.
- **Auto Reconnect** - Reconnects automatically after a disconnection occurs.
- **Delay before retrying** - Select the amount of time to delay the reconnection attempt after a disconnection occurs.
Drive Mapping

Use the *Drive Mapping* tab to map share names on the server to USB mass storage devices attached to the thin client, and to view and manage (add, edit, and delete) the list of current server share names (including drive information) mapped on the thin client.

**Adding Share Names**

1. Click **Add** to open the **Drive Map** dialog box.
2. Enter a **Share Name**.
3. Select a **Drive Type** (*USB Floppy*, *USB CDROM*, *USB Disk or Memory Stick*, or *Local or Mounted Disk)*.
4. (Optional) Enter the directory on the USB device to access in the **Base Directory** text box.
5. Click **OK** to add the **Share Name** to the list of available **Share Names**.

**Editing and Deleting Share Names**

To edit or delete a **Share Name**, select a **Share Name** from the list of available **Share Names** and do one of the following:

- **Edit** - Click **Edit** and configure the **Share Name** as described in "Adding Share Names."
- **Delete** - Click **Delete** to remove the **Share Name**.
VNC Viewer

Use the **VNC Viewer Settings** dialog box (click **VMware Viewer**) to set VNC Viewer connection configurations. After configuring, be sure to click **OK**.

![VNC Viewer Settings](image)

### Network

Use the **Network** tab to configure the network settings:
- **Description** - Enter a name/label for the connection.
- **Host** - Enter a host name or IP address.
- **Connect to** - Select a connection type of either Display number (enter the display to connect to on the server) or Port number (enter the port to connect to on the server).
- **Ping Before Connect** - Pings the connection to see if it is reachable before the connection is attempted.

### Connection

Use the **Connection** tab to configure the connection settings:
- **Compression Level** - Select a compression level for encoding.
- **Shared** - Enables or disables a shared connection.
- **View Only** - Blocks mouse and keyboard events for a view-only connection.

### Window

Use the **Window** tab to configure window settings:
- **Full Screen** - Opens the connection in a full-screen window.
- **Disable Panel** - Disables the panel while using the connection.
- **Color Depth** - Controls how many colors to display with each on-screen pixel.
- **JPEG Quality** - Specifies the image quality for encoding.

### Login

Use the **Login** tab to configure credentials used to automatically log in to the VNC server:
- **Password** - Enter the password to connect to the VNC server.
- **Connect automatically after login** - Enables an automatic connection after successful login to the thin client.
Web Browser

Use the **Web Browser Configuration** dialog box (click **Web Browser**) to set Web Browser connection configurations. After configuring, be sure to click **OK**.

---

**Network**

Use the **Network** tab to configure the description and URL (optional if you want the browser to open to a particular Web page each time you connect). If you want the browser to launch automatically after system startup, select the **Auto Connect** check box.

**Window**

Use the **Window** tab to configure how the browser window is displayed. If you want the browser to appear in fullscreen mode without any menus or toolbars, select **Kiosk Mode**. If you want the browser to appear without the panel while using the connection, select **Disable Panel**. If you are not using Kiosk Mode, you can select the **Window Size** you want from the list.

**Auto Reconnect**

Use the **Auto Reconnect** tab to enable automatic reconnect after a disconnection (select the **Enable Auto Reconnect** check box, and then select the amount of time to delay the reconnection attempt after a disconnection occurs).
Central Configuration: Automating Configurations

This appendix describes how to set up your environment to provide your thin clients running Wyse Enhanced Ubuntu Linux with automatic configurations in three simple steps.

It includes:

- "How INI Files are Employed"
- "How to Set Up Automatic Configuration"

Tip

Wyse thin clients do not require device management software. They are configured to obtain their IP address, as well as the location of configuration instructions, from a DHCP server. However, you can use Wyse Device Manager (WDM) for a more hands-on management of your thin clients. For information about configuring your thin clients to communicate with a WDM server, see "WDM" and related INI parameters in Reference Guide: Wyse Enhanced Ubuntu Linux INI Files.

How INI Files are Employed

INI files (created and maintained by the administrator) determine how the thin client is configured. The thin client accesses INI files from the server during the initialization process. Typically, INI files are accessed through FTP, HTTP, and HTTPS; if no protocol is specified, the default is anonymous FTP.

INI files are employed as follows:

- **wlx.ini** - This is the global INI file. One wlx.ini file is available to all users. It contains global parameters for all thin clients accessing the server. If the operating system cannot find wlx.ini, it defaults to wnos.ini.

- **{username}.ini** - This file is unique to each user. The {username}.ini file contains the connection profile for each user. Parameters in the user profile generally supersede the identically named global parameters.

- **$MAC.ini** - This file can be used for device-specific configuration. If the thin client locates this INI file (it is stored in the same directory as wlx.ini), wlx.ini is not accessed, unless you use the include=wlx.ini parameter.

When a thin client is initialized, it accesses the global wlx.ini file. When a user logs in, the thin client accesses the user’s unique {username}.ini file. For detailed information on constructing and using Wyse Enhanced Ubuntu Linux INI files, refer to Reference Guide: Wyse Enhanced Ubuntu Linux INI Files.

Tip

If both PNLite and a user profile are being used, the username must be defined in the Windows domain to be used, and the password must be the same for the domain and the profile.
How to Set Up Automatic Configuration

For a Wyse thin client running Wyse Enhanced Ubuntu Linux to successfully access INI files and configure itself from a server, you must set up the server with the correct folder structure (where the INI files and other files are located), direct the thin client to the server, and then reboot or start the thin client.

After DHCP and servers are configured and available, the thin client checks (at each boot up) to see whether or not any configuration changes are available on a predefined server (DCHP Option #161 specifies the server URL, DCHP Option #162 specifies the root path to the server). If configuration changes are available, the changes are automatically installed.

Step 1: Prepare the Root Directory and Folder Structure on the Server

Set up the following folder structure on your server under the C:/inetpub/ftproot folder (for FTP) or C:/inetpub/wwwroot folder (for HTTP or HTTPS) and place your INI files and other necessary files inside the structure as noted (this list describes the folder structure, starting with the root directory).

/wyse/ The root directory. It stores the wlx folder and the addons folder.

/wyse/wlx The main INI configuration folder. It stores the following:
- wlx.ini file or $MAC.ini file
- bitmap folder
- certs folder
- ini folder

/wyse/wlx(bitmap The folder where you can place custom images you plan to use.

/wyse/wlx/certs The folder where you can place the CA certificates that can be imported to a thin client. 
Note: Use the Certs and ImportCerts INI parameters in the wlx.ini file to import the certificates to thin clients.

/wyse/wlx/ini The folder where you can place the {username}.ini files.

/wyse/addons The folder where you can place the add-ons you want to use. It also stores the directory file and the *.deb packages available to be installed on the thin client. The directory file should list all available add-ons. The directory file is required in the addons folder to guarantee that add-ons are properly located.

NOTE: If you want to do an update with the Preserve changes option enabled, ensure that your addons folder includes a copy of your current add-ons. The system may require two reboots to fully update the add-ons while preserving local changes.
Be sure to create/activate the two required MIME Types (.ini and .) under IIS (on a per site basis) to enable downloading. Also be sure your Web server can identify the file types used by Wyse thin clients.

To create/activate the .ini MIME Type:

1. On your IIS server, use the **File Types** menu to add a **New Type**.
2. In the **File Type** dialog box, enter the **Associated extension .ini** and **Content type (MIME) text/plain**.
3. Click **OK** to apply the settings.

To create/activate the . MIME Type:

1. On your IIS server, use the **File Types** menu to add a **New Type**.
2. In the **File Type** dialog box, enter the **Associated extension .** and **Content type (MIME) text/plain**.
3. Click **OK** to apply the settings.

For detailed instructions on adding the .ini and . MIME Types, refer to Wyse Knowledge Base Solution #21581 (go to the Wyse Knowledge Base at http://www.wyse.com/kb and search for 21581).
Step 2: Direct the Thin Client to the Server

After you set up the folder structure and populate it with the correct files, you must then direct the thin client to the location of the server by one of the following ways:

- DHCP (see "Using DHCP")
- Manual direction (see "Manually Configuring the Server Location")

**Tip**
Using DHCP is *strongly recommended*.

Using DHCP

When using DHCP to direct the thin client to the location of the server (recommended), information about the server and root directory is obtained from the following DHCP options:

- **161** - The server.
- **162** - Root path to the server (ftp/http/https).
  - If no root path is defined, `/wyse` is assumed.
  - If a root path is defined, the additional path will be appended to the URL supplied by option 161.
- **184** - (Optional) Server username (to server specified in option 161).
- **185** - (Optional) Server password (to server specified in option 161).

**Tip**
Check-in for configuration changes is done early in the boot process. For that reason, changes in DHCP information may not be propagated to a unit until a full boot is completed. However, you can avoid this by forcing a renewing of the DHCP lease, which makes sure that the unit has the latest file-server location before the next check. Simply, right-click the Network Manager icon, click Enable Networking to disable it, right-click the Wireless Manager icon, and then click Enable Networking to enable it again (the DHCP lease is renewed).

**Tip**
For general instructions on adding DHCP Options #161 and #162, refer to Wyse Knowledge Base Solution #16132 (go to the Wyse Knowledge Base at http://www.wyse.com/kb and search for 16132).

Use the guidelines shown in Table 3 when creating and adding the DHCP options you need.

**Table 3 DHCP Option Tags**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Client identifier</td>
<td>Always sent.</td>
</tr>
<tr>
<td>2</td>
<td>Time Offset</td>
<td>Optional.</td>
</tr>
<tr>
<td>3</td>
<td>Router</td>
<td>Optional but recommended. It is not required unless the thin client must interact with servers on a different subnet.</td>
</tr>
<tr>
<td>6</td>
<td>Domain Name Server (DNS)</td>
<td>Optional but recommended.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Notes</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>12</td>
<td>Host Name/Terminal Name</td>
<td>Optional string. The host name or terminal name to be set.</td>
</tr>
<tr>
<td>15</td>
<td>Domain Name</td>
<td>Optional but recommended. See Option 6.</td>
</tr>
<tr>
<td>28</td>
<td>Broadcast Address</td>
<td>Optional.</td>
</tr>
<tr>
<td>44</td>
<td>WINS servers IP Address</td>
<td>Optional.</td>
</tr>
<tr>
<td>51</td>
<td>Lease Time</td>
<td>Optional but recommended.</td>
</tr>
<tr>
<td>52</td>
<td>Option Overload</td>
<td>Optional.</td>
</tr>
<tr>
<td>53</td>
<td>DHCP Message Type</td>
<td>Recommended.</td>
</tr>
<tr>
<td>54</td>
<td>DHCP Server IP Address</td>
<td>Recommended.</td>
</tr>
<tr>
<td>55</td>
<td>Parameter Request List</td>
<td>Sent by appliance.</td>
</tr>
<tr>
<td>57</td>
<td>Maximum DHCP Message Size</td>
<td>Optional (always sent by thin client).</td>
</tr>
<tr>
<td>58</td>
<td>T1 (renew) Time</td>
<td>Optional but recommended.</td>
</tr>
<tr>
<td>59</td>
<td>T2 (rebind) Time</td>
<td>Optional but recommended.</td>
</tr>
<tr>
<td>61</td>
<td>Client identifier</td>
<td>Always sent.</td>
</tr>
<tr>
<td>161</td>
<td>Server (ftp/http/https)</td>
<td>Optional string. If this is an IP address or resolvable hostname, the protocol is assumed to be FTP; however, it may be the leading portion of a URL that specifies another protocol. If using the URL form, it should not include a trailing slash (for example, <a href="http://server.example.com">http://server.example.com</a> or ftp://192.168.0.1).</td>
</tr>
<tr>
<td>162</td>
<td>Root path to the server (ftp/http/https)</td>
<td>Optional string. The relative directory starting from the root directory must be given. For example, on an FTP server, the full directory may be C:/Inetpub/ftproot/wyse, where wyse is the directory that contains the INI files. In this example, the correct string value for this DHCP option is /wyse. On a Linux server, an FTP user-based directory might be /home/test/wyse. In this example, if the FTP user is test, then the FTP root path is /wyse and not the full path (/home/test/wyse). This value should use URL path notation (start with a forward slash, /, and use a forward slash as folder separators).</td>
</tr>
<tr>
<td>181</td>
<td>Wyse PN Server</td>
<td>Optional string. IP address or FQDN of the PNLite server.</td>
</tr>
<tr>
<td>182</td>
<td>Wyse Admin List</td>
<td>Optional string. DHCP equivalent of the DomainList ini file parameter.</td>
</tr>
</tbody>
</table>
### Manually Configuring the Server Location

To manually configure the server location (*not* recommended), open the **INI Settings** dialog box (click **System Settings** icon and then click **INI Settings**), and enter the URL (for HTTP or HTTPS; FTP URL is allowed for FTP) for the INI server in the **INI Server URL** text box. For more information, see "INI Source Settings."

![INI Settings dialog box](image)

---

### Step 3: Reboot the Thin Client

After you reboot (or start the thin client), the thin client will look in the defined root path for the latest available configuration changes if necessary. Additionally, it will check the **directory** file in the **addons** folder to see if any changes for installed add-ons are defined. Add-ons that exist in the **addons** folder but are not listed in the **directory** file, will be ignored during check-in.
This page intentionally blank.
Administrators Guide

Wyse® Enhanced Ubuntu Linux
Issue: 022412

Written and published by:
Wyse Technology Inc., February 2012

Created using FrameMaker® and Acrobat®